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Introduction

GalleryWatch is part of Label Gallery TruePro software package, which lets you create and
print labels with ease and in fully WYSIWYG style. GalleryWatch enables communication
and synchronization of the label production process with certain events. If one or more of
these events take place, the pre-defined action is triggered.

GalleryWatch can:

e Run Label Gallery and manipulate label at the appearance of a trigger file, receipt of an
e-mail message, TCP/IP socket connection or COM port activity. These activities are
called trigger events and they are a signal for GalleryWatch to start with action
execution.

e Send label data via current Internet technologies using TCP/IP socket connection or a
text-based email. Thus mobile users can print labels from any location to any printer.

e Send GalleryCommands to Label Gallery at the occurrence of trigger event (open label,
print label, send commands through JOB file, set variables, etc). With
GalleryCommands a better control over the label data and printing can be accomplished.

e Easily parse and map data from non-typical data streams to label variables. Data can be

easily extracted from non-structural data sources and transferred to the variable fields on
the label.

e Use the most productive means available to initiate label printing from mobile wireless
devices. Mobile devices can print the labels by themselves or initiate label printing on a
remote printing server.

e Watch up for unlimited number of different events with special action for every trigger
event. GalleryWatch can concurrently monitor mixed triggers events.

e Manipulate data files when an event occurs.




Setting Up GalleryWatch

User Interface

Basic and Advanced User Interface

GalleryWatch software has two-level user interface. By default, basic user interface is enabled
that makes the software easier to use for beginners and inexperienced users.

To switch to the Advanced mode showing all program functionality, click on the Advanced
button in the bottom of some dialog boxes.

For example:
The dialog box Actions Editor has two-level user interface.

Main Window

Click on the part of the GalleryWatch client window to see the description.
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Customizing the Software
To change the preferences of the application, do the following:
1. Select Options command in the Tools menu.
The Options dialog box opens.
2. You can change the options regarding the printing and logging of activity.
To customize the menus and toolbars, do the following:
1. Select Customize command in the Tools menu.
The Customize dialog box will open.
2. Make modifications to the settings.
3. Click on the OK button.
Note:
You can also change the positions of the toolbars on-screen. Just drag them to the new
position.




Working with Triggers

Defining Actions

Advanced Options for Label Quantity

Number of Skipped Labels: This many labels will be skipped on the first page of labels. the
option is useful is some labels on the sheet have already been used and you would like to use
the rest of the labels on the same page.

Note:
The option for skipping labels is applicable when printing labels to office printers. It is
not available when using thermal printers.

Identical Label Copies: The option sets the number of label copies you want to use with

every printed label.
Label Sets: The option instructs how many times the printing process should be repeated.

For example:
If you set Number of Labels to Fixed 5 and Number of labels sets to 3 in the Advanced

Options, the printing of 5 labels will be repeated three times, resulting in 15 printed
labels.

Advanced Options for Load Variable
Data

Advanced options for the text file containing the exported data are defined in this dialog box.
Variables: Select which variables you want to load from the text file.
e All variables: The default setting is to load all variables.
e Selected variables: Click on the Select button and select the variables you want to
load.
Other: Define the delimiter and text qualifier as are used for the text file.

Advanced Options for Save Variable
Data
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Advanced options for the text file containing the exported data are defined in this dialog box.
Variables: Select which variables you want to save to the text file.
e All variables: The default setting is to load all variables.
o Selected variables: Click on the Select button and select the variables you want to
load.
If File Exists: Define the action, if the file already exists.
Other: Define the delimiter and text qualifier as are used for the text file.

Open Document/Program

The action executes the specified program or opens the specified document, when the button
is clicked.

File Name: Define a file name for the document/program that you want to open. Include full
path to the program or document.

Note:

If you are opening a program, you can also include variables as parameters in the
command line. Enclose the variables in the square brackets. For example: c:\program
files\my program.exe [Variable]

Condition: This is a Visual Basic Script boolean expression. Only two results are possible
(True and False). Use this option to enable current action only when some term is met. The
action will be started only if condition returns True as the result of the expression.

Open Document/Program

The action executes the specified program or opens the specified document, when the button
is clicked.

File Name: Define a file name for the document/program that you want to open. Include full
path to the program or document.

Note:

If you are opening a program, you can also include variables as parameters in the
command line. Enclose the variables in the square brackets. For example: c:\program
files\my program.exe [Variable]

Condition: This is a Visual Basic Script boolean expression. Only two results are possible
(True and False). Use this option to enable current action only when some term is met. The
action will be started only if condition returns True as the result of the expression.

Open Label
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This action defines the label file that will be used to printing, when the user clicks on the
button.

Label: Define the fixed name of the label or select the variable containing the path and name
to the label.

Condition: This is a Visual Basic Script boolean expression. Only two results are possible
(True and False). Use this option to enable current action only when some term is met. The
action will be started only if condition returns True as the result of the expression.

Note:

The action Open Label can contain other actions nested below it. You must always use
the Open Label action to print labels and executing some other actions. Such actions
cannot exist on their own, but are always nested below Open Label action.

Other Actions

Condition: This is a Visual Basic Script boolean expression. Only two results are possible
(True and False). Use this option to enable current action only when some term is met. The
action will be started only if condition returns True as the result of the expression.

Print Label

This action executes the printing command and defines how many labels will be printed.
Number of Labels: Define how many labels should be printed.
e Fixed: The number entered in the edit field defines how many labels will be printed.
e Unlimited: The maximum quantity of labels supported by the current printer will be
printed. This options is generally used with database files, where unlimited would be
used as: print the whole database.

Note:
Be careful and do not create an infinite loop, when label printing would not end.

e Variable quantity: Some variable on the label will set the quantity of labels to be
printed. In most cases this will be some field from the database. The application does
not know how many labels will be printed. When the data is processed on the label,
the variable quantity gets its value.

e From variable: The value of the selected variable defines the quantity of labels that
will be printed.

Advanced Options: Click this button to set advanced options for the quantity of labels.
Condition: This is a Visual Basic Script boolean expression. Only two results are possible
(True and False). Use this option to enable current action only when some term is met. The
action will be started only if condition returns True as the result of the expression.

Run Job
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Executes commands in the specified JOB file.

File Name: You can set a fixed JOB name or let some variable define it. The JOB file is a
plain text file containing GalleryCommands for controlling printing actions in Label Gallery
Plus.

Condition: This is a Visual Basic Script boolean expression. Only two results are possible
(True and False). Use this option to enable current action only when some term is met. The
action will be started only if condition returns True as the result of the expression.

Send Custom Commands

Send the defined list of GalleryCommands to the Label Gallery Plus for execution.
Commands: Enter the GalleryCommands in the text area.

Edit: Click on the Edit button to open the Expression Editor that will help you define the
script of custom commands.

You can also include variables in the commands. Just type in the variable name and enclose it
with the square brackets.

For example:
To print the number of labels as specified in the variable Quantity, the print command
should look like PRINT [Quantity]

Condition: This is a Visual Basic Script boolean expression. Only two results are possible
(True and False). Use this option to enable current action only when some term is met. The
action will be started only if condition returns True as the result of the expression.

Note:
For more information about GalleryCommands refer to Label Gallery Plus help or User
Guide.

Load Variable Data

This action reads the data from the text file and sets values to the variables on the form.

File Name: Specify the name of the text file with data. It can be fixed or variable.

Advanced Options: Click on this button to select variables you want to load from the text file
and define the structure of the text file.

Condition: This is a Visual Basic Script boolean expression. Only two results are possible
(True and False). Use this option to enable current action only when some term is met. The
action will be started only if condition returns True as the result of the expression.

Save Variable Data
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This action saves the data from the variables to the text file.

File Name: Specify the name of the text file with data. It can be fixed or variable.

Advanced Options: Click on this button to select variables you want to load from the text file
and define the structure of the text file.

Condition: This is a Visual Basic Script boolean expression. Only two results are possible
(True and False). Use this option to enable current action only when some term is met. The
action will be started only if condition returns True as the result of the expression.

Select Variables

Select the variables which values you want to save/load to/from file. Use Up and Down
arrows to set the order of appearance in which values are defined in the text file.

Set Printer

The action defines the printer name that you want to use for label printing. This setting will
override the printer setting that were set directly on the label.

Note:
This action is useful, if you want to print one label file to several different printers
without the need for creating duplicated label files linked to different printers.

Printers: Define fixed name of the printer or select the variable name containing the name of
the printer.

Condition: This is a Visual Basic Script boolean expression. Only two results are possible
(True and False). Use this option to enable current action only when some term is met. The
action will be started only if condition returns True as the result of the expression.

Set Variable

The actions sets the defined value to the selected variable.

Condition: This is a Visual Basic Script boolean expression. Only two results are possible
(True and False). Use this option to enable current action only when some term is met. The
action will be started only if condition returns True as the result of the expression.

Visual Basic Script
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This action defines the programming script that you can use for advanced data manipulation.
The action has the possibility to use all standard VB Script functionality. In addition the script
is also able to get and set values of the variables and to read and write to/from the serial port.
Visual Basic Script: Define the script in the text area.

Build Script: Click on this button to open the Expression Editor that will help you construct
your script.

Check Script: Click on this button to verify the syntax of you script. If there is a syntax error
in the your script, you will be notified about it.

Defining Triggers

Using COM Port Trigger

Using COM Port Trigger

To define the trigger do the following:
1. Select the command Add Trigger from the Edit menu.
2. Select the command COM Port.
The properties of the new COM Port trigger will open.

Note:

You can also click on the icon in the trigger toolbar.

Go to the COM Port tab.
Define the properties of the serial port.
Go to the Action tab.
Define the actions that should be executed, when the trigger occurs.
Click on the OK button.
The trigger is ready for usage.
If the COM Port trigger provides data values for the labels, you will have to extract the values
from the incoming data and transfer them to the variables. Do the following:
1. Double click the COM Port trigger to open its properties.
2. Go to the Variables tab.
3. Define the variable that exist on the label.

Note:
You can manually define the variables or import the from the label file. If creating
variables manually, make sure to use the same names as are defined in the label.

Go to the Filter tab.

Tick the option Use filter to enable filter functionality.

Select the appropriate Filter type that matches the format of the incoming data.
Define the fields in the incoming data stream.

Link the fields with the variables.

. Click on the button Verify the Definition to test the processing of your filter.
0. Click on the OK button.
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Using Email Trigger

Using Email Trigger

To define the trigger do the following:
1.
2. Select the command Email.

Select the command Add Trigger from the Edit menu.

The properties of the new Email trigger will open.

Note:
You can also click on the icon in the trigger toolbar.

® NNk

Go to the Email tab.

Define the properties of the email trigger.

Go to the Action tab.

Define the actions that should be executed, when the trigger occurs.
Click on the OK button.

The trigger is ready for usage.

If the Email trigger provides data values for the labels, you will have to extract the values
from the incoming data and transfer them to the variables. Do the following:
1.
2. Go to the Variables tab.
3. Define the variable that exist on the label.

Note:
You can manually define the variables or import the from the label file. If creating
variables manually, make sure to use the same names as are defined in the label.

—= 00N LA

0.

Double click the Email trigger to open its properties.

Go to the Filter tab.

Tick the option Use filter to enable filter functionality.

Select the appropriate Filter type that matches the format of the incoming data.
Define the fields in the incoming data stream.

Link the fields with the variables.

Click on the button Verify the Definition to test the processing of your filter.
Click on the OK button.

Using File Trigger

Using File Trigger

To define the trigger do the following:
1.
2. Select the command File.

Select the command Add Trigger from the Edit menu.

The properties of the new File trigger will open.

10
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Note:

You can also click on the icon in the trigger toolbar.

Go to the File tab.
Define the properties of the files you will monitor..
Go to the Action tab.
Define the actions that should be executed, when the trigger occurs.
Click on the OK button.
The trigger is ready for usage.
If the File trigger provides data values for the labels, you will have to extract the values from
the incoming data and transfer them to the variables. Do the following:
1. Double click the File trigger to open its properties.
2. Go to the Variables tab.
3. Define the variable that exist on the label.

Note:
You can manually define the variables or import the from the label file. If creating
variables manually, make sure to use the same names as are defined in the label.

Go to the Filter tab.

Tick the option Use filter to enable filter functionality.

Select the appropriate Filter type that matches the format of the incoming data.
Define the fields in the incoming data stream.

Link the fields with the variables.

. Click on the button Verify the Definition to test the processing of your filter.
0. Click on the OK button.

XN
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Using TCPIP Trigger

Using TCP/IP Trigger

To define the trigger do the following:
1. Select the command Add Trigger from the Edit menu.
2. Select the command TCP/IP.
The properties of the new TCP/IP trigger will open.

Note:

You can also click on the icon in the trigger toolbar.

Go to the TCP/IP tab.
Define the properties of the TCP/IP server.
Go to the Action tab.
Define the actions that should be executed, when the trigger occurs.
Click on the OK button.
The trigger is ready for usage.
If the TCP/IP trigger provides data values for the labels, you will have to extract the values
from the incoming data and transfer them to the variables. Do the following:
1. Double click the TCP/IP trigger to open its properties.
2. Go to the Variables tab.

Sl AR o

1



GalleryWatch User Guide

3. Define the variable that exist on the label.

Note:
You can manually define the variables or import the from the label file. If creating
variables manually, make sure to use the same names as are defined in the label.

Go to the Filter tab.

Tick the option Use filter to enable filter functionality.

Select the appropriate Filter type that matches the format of the incoming data.
Define the fields in the incoming data stream.

Link the fields with the variables.

. Click on the button Verify the Definition to test the processing of your filter.
0. Click on the OK button.

—~ 00N LA

Using Filters

Filter Document Analysis

Document Analysis

The filter type Document Analysis can is used to acquire fields from unstructured data
sources. There are two main types of such data are often in use.

Report Report files are an example for data format with repeatable data in semi-
files defined form. The header and footer parts of the report are usually the same
and are containing company related information (address, phone, email etc.).

You have two options when using document analysis with report files:

= Use repeatable area: Here you define part of the document as
repeatable area. Each line (or more lines) represents one record and is
used on one printed label. Repeatable area can be referred to as the
text database. Repeatable data area usually contains fixed columns of
data. When you are working with the repeatable area, you refer
relatively to the are and do not use absolute positions of the data in the
document.

= Use document field: Here you extract fields from the absolute
positions in the document. For each field you have to define the start
and stop position.

You can also combine the repeatable area and document field in the same
filter. The document fields will be the same on every printed label based on
this report file. The fields from the repeatable area will change on each label.

Printer This type of data source is totally unstructured file format, but you generally
command  know where the fields are positioned or they are enclosed in some well-
files known prefix and suffix text. Commands have always the same syntax with

12
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changeable parameters so they can be easily identified in the data stream.

In this case you normally use the document fields. You have to properly
define the field start and stop areas to extract the data you need on the label.
Often you cannot refer to the fixed positions in the document as the same data
is not always placed on the same location. You can search for some prefix or
suffix text and then define the field using offsets from the prefix and suffix.

Add: click on the Add button to define repeatable area and document fields.
Edit: Change properties of the existing field.
Delete: Remove the existing field.
When you have the structure of the fields defined, you have to link the fields with the
variables. Do the following:

1. Double click on the field name.

The Document Field Properties dialog box will open.
2. Select the appropriate variable from the list.

Note:
If no variables are defined, go to the Variable tab and define the variables. Then return
to the Filter tab and repeat the process from step 1.

3. Click on the OK button.

Document Field Properties

Field Properties
* Field name: Define the field name. Each field must have a unique name.
* Variable: Select the variable to which the field will transfer its value.
Field Start: Define the start position of the field.

* Row number and Column number: Use these options, if the field data always
begins/ends on the some row/column position.

* Prefix word and Offset rows: Use these options, if the field does not always start on
the same spot. You can look for some prefix word and offset the field up or down for
the specified number of rows.

Field Stop: Define the stop position of the field.

* Row number and Column number: Use these options, if the field always
begins/ends on the some row/column position.

* Prefix word and Offset rows: Use these options, if the field does not always finish
on the same spot. You can look for some prefix word and offset the field up or down
for the specified number of rows.

* End of the line: The field extends from the start point until the end of the line.

Truncate spaces before the first and after the last character: Select this option, if you
want to remove the trailing and leading spaces from the value.

Mapping the Document Variables

13
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The dialog box Document Field Properties is used to link the fields from the document to the
variables. The dialog box is also used to define the position of the fields in the document. The
same dialog box is used for both, document fields and fields from the repeatable area.

Note:

The difference between the document fields and fields from the repeatable area is that
document fields appear absolutely on the document, while repeatable fields appear
relatively in the repeatable area. You have to take this into consideration when defining
the field start/stop positions.

If you are using only document fields, the input data from trigger will be used on all labels. If
you are using repeatable variables, each item in the repeatable area will be used on one label.
If the repeatable area contains 10 rows, the data from each row will be used on one label. You
can combine the document and repeatable variables on the label. Document variables will stay
the same for all occurrences of repeatable variables and will be the same for all printed labels
for the trigger, but repeatable fields will change for each item.

Note:
You can use the data from more consecutive lines on a single label. Change the option
Number of rows of the repeatable part when defining the repeatable area.

To create the document fields or fields in the repeatable part and link them to the variables, do
the following:
1. Click on the Add button to open Document Field Properties dialog box.
2. Define the field name.
3. Select the variable that will be linked with the field. The value of the field will be
transferred to the variable when the filter is processed.
4. Define the parameters for the Field Start and Field Stop.

Note:

The start and end of the area is defined using three parameters. Row number, Column
number and Prefix word. Only two parameters are required to successfully define the
start/stop area. For example, if you know that the data will start in row number 10, and
that required data is always preceded with string "Data #", you would enter 10 to Row
number "Data #" to Prefix word and leave Column number to 0.

5. Tick the option Truncate spaces before the first and after the last character, if you
want to remove the trailing and leading spaces from the value.
6. Repeat this procedure from step 1 for all other fields you want to set.

Note:
If no variables are defined, go to the Variable tab and define the variables.

Repeatable Data Area
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X]

[ 1End of the file

1

4

| ok || cacel || Hep |

Defining repeatable data area

The repeatable data area defines the part in the document that contains the formatted data
area. Usually the repeatable area can be interpreted as the text database with columns of the
fixed width. You have to define the start and the end of the area that contains repeatable data,
and at the same time set the number of rows of repeatable part.

Area Start: Define the start position of the repeatable area.

Row number and Column number: Use these options, if the repeatable data area
always begins/ends on the same row/column position.

Prefix word and Offset rows: Use these options, if the repeatable area does not
always start on the same spot. You can look for some prefix word and offset the
repeatable area up or down for the specified number of rows.

Area Stop: Define the stop position of the repeatable area.

Row number and Column number: Use these options, if the repeatable data area
always begins/ends on the same row/column position.

Prefix word and Offset rows: Use these options, if the repeatable area does not
always finish on the same spot. You can look for some prefix word and offset the
repeatable area up or down for the specified number of rows.

End of the file: The repeatable area extends from the start point until the end of the
file.

Note:

The start and end of the area is defined using three parameters. Row number, Column
number and Prefix word. Only two parameters are required to successfully define the
start/stop area. For example, if you know that the data will start in row number 10, and
that required data is always preceded with string "Data #", you would enter 10 to Row
number "Data #" to Prefix word and leave Column number to 0.

Number of rows of repeatable part: Use this option, if the data for one label uses more
consecutive lines in the repeatable part. By default this option is set to 1, so each line in the
repeatable part provides value for one label.
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Sample Documents for the Document
Analysis Filter

The document with repeatable part and document fields

The red colored areas are document fields.

The yellow colored area is the repeatable are containing six fields: Product ID, Product Name,
Quantity, Unit Price, Discount, Extended Price.

INVOICE

One Portals Way, Twin Points WL 95156
Phone: 1-206-555-1

Date: 20-fekb-Z00Z

Ship To: Bill To:
SPAR Supermarkt Richter Supermarkt
Itarenwveg 5 Grenzacherweg =237
Genewe 1204 Genewve 1203
Switzerland Switzerland
Order Customer Jalesperso Order Date FRequired Date 3hip Via
11075 RIC3T Laura Callahan 06-maj-1995 03-jun-1995 Tnited Package

Product ID Product Name dnantity Unit Price Discount Extended Price

2 Chang 1 $19,0 15% 161, 50

45 Spegesild 1 $12,0 15% 306,00

76 Lakkalikoori & $18,0 15% 30,60

Subtotal: $495,11
Freight: 36,19
Total: $E04, 294

The document with only repeatable part
The document with repeatable part set for the whole file and Number of rows in the
repeatable part set to 8.
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Header :"watch sample"

formatname=c:WpProgram FileshsaTohvGallery 2hvsSampleshLabelssTabell. 1b1
formatcount=1

useprinter=saTo

code="000001"

article="HAMMER"

ean="383880025501"

weight="4,50 kg"

formatname=C:ivpProgram FileshsaTovGallery 2hvsampleshLabelsyTabelz. 1b1
formatcount=2

useprinter=saTo

code="000002"

article="LABEL_GALLERY"

ean="111111111112"

wedght="3,00 kg"

Filter Text Database Analysis

Field Properties

Field Properties
* Field name: Define the field name. Each field must have a unique name.
= Variable: Select the variable to which the field will transfer its value.
Delimited Data Type: Select which field should be linked to the variable and set the length

of the field.

Note:

This option is available only if your database type is delimited.
Fixed Data Type: Select which field should be linked to the variable and set the length of the
field.

Note:

This option is available only if your database type is fixed.
Truncate spaces before the first and after the last character: Select this option, if you
want to remove the trailing and leading spaces from the value.

Mapping the Text Database Variables

To link the text database fields to the variables, do the following:
1. Define the structure of your text database. All fields must be visible in the text are in

Text Database Analysis Option section.
2. Double click on the field entry in the list.
The dialog box Field Properties will open.
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3. Select the variable that will be linked with the field. The value of the field will be
transferred to the variable when the filter is processed.

4. Tick the option Truncate spaces before the first and after the last character, if you
want to remove the trailing and leading spaces from the value.

5. Repeat this procedure from step 2 for all other fields you want to set.

Note:
If no variables are defined, go to the Variable tab and define the variables.

Text Database Analysis

Use this option if your trigger input data is in structured data format. The data type structure
can be either:

fixed The width of the fields is always the same.

delimited The fields are separated by some character.

First you will have to define the type structure. You have two methods to define the structure
of the text database:
1. Click on the Add button and define the structure in the Text Database
Properties dialog box that opens.
2. Click on the Get Fields button to open the Text File Wizard that helps you define the
structure of the text database in a few steps. Browse to the text database that has the
same structure as the text database that will be received from the triggers.

Text Database Properties

Define the structure of the text data you want the process in the filter. The source of this text
data is one of the triggers. The text data is internally passes to the filter, which processes the
text file, gets the value of the fields and transfers the values to the variables.
Data Type: Select the type of your database.

* Delimited: The fields in the database are separated by some delimiter. Common type

of such text database is comma separated values file (.CSV).

* Fixed: The data values are formatted in the fixed columns.
Start import at row: Specify the line in text source where the data really begins. A few lines
on the top are usually used for headers and comments that explain the data structure.
Delimiter: Use this option, if database type is Delimited. Select the delimiter that your text
database uses. You can use any of pre-defined delimiters or define your own one.
Text qualifier: If your data fields include the delimiter character as the value, you need to
enclose such data values in the text qualifier characters. Usually it is double quote or single
quote.

For example:
If you use a comma for delimiter, this is how you would encode the comma in the field
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value using double quote as the qualifier character: "1,2,3","abc","a,b,c". The field data
is enclosed by the qualifier characters.

Filter XML Database Analysis

Mapping the XML Fields to the
Variables

Once you have the structure defined, you must map the XML data types to the variables.
Do the following:
1. Define the structure of your XML database. All fields must be visible in the text are in

XML Database Analysis Option section.
2. Double click on the field entry in the list.
The dialog box Field Properties will open.

3. Tick the variable that will be linked with the field. The value of the field will be
transferred to the variable when the filter is processed.

4. The data type that needs to provide recurring data needs to be defined as recurring
element. Only these data types can be marks as repeatable block, a property that
ensures the recurring elements.

5. Tick the option Truncate spaces before the first and after the last character, if you
want to remove the trailing and leading spaces from the value.

6. Repeat this procedure from step 2 for all other fields you want to set.

Note:
If no variables are defined, go to the Variable tab and define the variables.

XML Database Analysis

Use this option if you have the data organized in the external structured XML file.
First you will have to define the type structure. You have two methods to define the structure
of the XML database:

1. Click on the Add button and define the structure in the XML Field Properties dialog
box that opens.

2. Click on the Get the Structure button to open the wizard that helps you define the
structure of the XML database. Browse to the XML database that has the same
structure as the XML database that will be received from the triggers. Click on the
Import button to finish the importing process.

Edit: Edit the properties of the selected entry.

Delete: Use this button to remove not needed fields. You do not need to display a whole
XML structure. The data is still contained in the external file, just the preview on the structure
is simplified.

Use the arrow buttons to fit the data structure to your needs. You can only move the data
types up and down in the structure of the same level. If you have imported the XML structure
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from an external file and you do not need all the fields on the label, you can simplify the view
on the structure.

Verify the Definition: Once you have the structure defined and variables mapped, test the
functionality of your filter. Click on this button to open some XML data file and validate the
filter. This button will simulate the execution of the filter. The functionality is the same as if
the action would be triggered, but no label is printed. The dialog box with data values is
shown as would be used on the label.

XML Field Properties

To define a new field for the XML structure the following properties must be defined.

Field name. Specify the field name to easier identify its contents and to separate it from other
fields.

Field type. Can be one item from the following list.

element This data type is the basic construct in the XML definition. Each
element can contain a data (an thus acts as the attribute) or can
contain additional structure of sub-fields (constructed from element,
recurring elements or attributes).

recurring element This data type can have the same syntax as normal element and can
be used in the same manner. But it must be used with recurring
data. Only the data structure defined as recurring element can be
marked as repeatable block and used as such.

This type defines the fields that will be repeated for the element one
level above.

attribute This data type contains the value of the field. It is the smallest data
type and cannot be divided into parts.

Get variable name from field data: Tick this option whenever the name of the variable is
defined in the XML structure itself as an attribute in some XML variable. GalleryWatch will
then take not only the value for this variable from the XML file, but also its name and assign
the value to the label variable with the same name. First, this option needs to be enabled for
the variable in the XML file that contains the variable names and values. Second, this option
needs to be enabled also for all appropriate attributes (label variable names) for this variable.
During the attribute selection you must select all the label variables that you expect to appear
in the XML. The actually used variable name cannot be anticipated in advance, so you need to
select all that might appear.

Variable: This is the variable defined on the label or in GalleryWatch application. It will get
the value stored in the selected field from XML file.

Truncate spaces before the first and the after the last character: Select this option if you
want the filter to remove leading and trailing white space characters from the extracted data.
Use element as repeatable block: Tick this option to define the current field as a repeatable
block. The repeatable block is a data structure that can provide two or more records for the
element which defines the block. Such field should in fact be a node containing further sub-
fields. Imagine yourself having a XML file with address data of your colleagues. Each
colleague can have more than one address specified (home, work...). The element Address
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contains sub-fields Street, Region, ZIP code and Country. If you want to use your friend's
name with all the associated addresses, this element has to be specified as repeatable block. If
the Address element is not defined as repeatable block, only the first data value is used.

Selecting the Filter Type

Selection of the proper filter type for your trigger is based on the structure of the input data.
The received data is usually formatted in one of the following formats:

unstructured files Document analysis filter
This filter can be used with data that has no structure
whatsoever. The perfect example for this filter is a report file
or printer data stream file (text file with printer commands).
Use this filter to define data-parts within received data, that
you want to assign to certain variables.

structured files Text database analysis
This filter can be used with a classic text database files that
hold the data for variable fields on the label. Data can be
encoded with:

= Fields of fixed width or

» Fields, delimited with some character. Different
delimiters can be used for separators between field
values.

structured files XML database analysis
This filter can be used with data formatted in XML files.

Working with Filters

Filters provide the functionality to extract the data from the incoming data stream received by
any of the triggers and to transfer that data to the variables. You do not have to send the
incoming data to files and use files with the filter. The data flows transparently from the
trigger through the filter.

Note:
The data for filters is provided with your trigger. Output of the trigger will be used as
input for the filter.
Different filter are available in the software. Use the appropriate filter that matches the
structure of your incoming data.
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Using Serial Port Communication

Defining Data Polling

This option data polling enables constant communication with the serial device. In specified
time intervals the defined data characters are sent to the device. The device understands the
sequence of characters as command to send the data to the PC computer.
There are two methods of defining the data for polling:
1. The characters you want to send to the device can be entered in the memo box below.
Use the button with arrow on the right to enter special characters.
2. Ifyour serial device can return the information of its status, you can use the built-in
Visual Basic functionality and write a script that will communicate with the device.
Visual Basic Script functionality lets you manipulate the incoming data. Two
functions are pre-defined and must existing in your script. DataAvailable and
ReceiveData both return Boolean values.

DataAvailable This function is used to acquire data from the serial device and
validates the incoming data for consistency.

You can use internal functions Comport.Send and Comport.Receive
to communicate with the device. Learn more about them in the
topic Defining Initialization Data.

If you set the function to return 1, the ReceiveData function is then
executed. If you set it to return 0, no incoming data is available and
action is not triggered.

The focus is returned to the next polling interval.

ReceiveData You can pass the incoming data from the serial device acquired in
DataAvailable function to this function. ReceiveData function can
then be used to manipulate incoming stream of data to suit your
needs. You can re-arange data fields, add or remove text and make
any other data operations.

If you set the function to return 1, the trigger action is then started.
If you set it to return 0, it will be a signal for the trigger not to start
the actions.

The focus is returned to the next polling interval.

ClearBuffer This command clears input and output buffers of the serial port on
the PC computer.

Defining Initialization Data
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Initialization data is set of characters that need to be sent to the serial device in order to
activate it and make it ready to send data to the PC computer. There are two methods how the
initialization data is defined:

1. If you have a dummy serial device that is activated by a certain combination of
characters, you can type in such characters. Click on the small arrow button on the
right to display list of all available special characters.

2. Ifyour serial device can report its current working state back to the computer, you can
use Visual Basic script and communicate with the serial device. You can program
your script code to handle bidirectional communication to the serial device.

When you are using bidirectional communication, the ordinary scenario is to send some
initialization string to the device and then listen for a reply. If the reply is what you are
expecting it to be, the initialization was successful. If the reply is not valid, the initialization
failed, an error in logged the system log, but trigger will still be checked.

Two special functions are available in Visual Basic script for data sending and receiving
to/from serial port.

Comport.Send ComPort.Send(Data: string, Length: integer): integer

The ComPort class function Send has two parameters. The first
parameter contains the data that will be sent to the serial port.
The second parameter must contain the length of the sent data.
Function return integer values:

1 - if writing to serial port was successful and

0 - if error occurs.

Comport.Receive ComPort.Receive(TimeOut: integer): string

The ComPort class function Receive has parameter TimeOut.
This parameter contains the time (in seconds), how long the
function will wait for the incoming data.

The function returns data if it is available in the specified time
frame. If the data is not received, the function returns empty
string.

The built-in function InitData must be part of the script code, but you are free to modify it.
Use the functions Comport.Send and Comport.Receive to exchange data with the serial device
and then decide if the initialization was successful or not.

Then set the output of the InitData function accordingly to let GalleryWatch know the result
of the initialization sequence.

Note:
The initialization string is sent to the serial device only at a time when you start trigger
checking in GalleryWatch or when you restart GalleryWatch service.

Using Toolbars

Using Server Toolbar
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Click on this button to start the GalleryWatch server.
Note:
If GalleryWatch server is not running, no triggers events are detected and no actions
are started.

Click on this button to stop the GalleryWatch server.

Refresh the connection to the server. The configuration of triggers, trigger status and
server parameters are obtained from the server.
If you do not see the server toolbar, do the following:
1. Select the command Toolbars from the View menu.
2. Enable the Server toolbar.

Using Standard Toolbar

Create a new .MIS (Middle-ware Integration Server) configuration file. The
configuration file stores the properties of the trigger events, filters and actions you
define.

Open settings from an existing configuration file.

L]

Save the existing settings into the configuration file.

Copy the definition of the selected trigger to the clipboard.

[ [

Paste the configuration of the trigger from the clipboard.

et
—t

you do not see the standard toolbar, do the following:
1. Select the command Toolbars from the View menu.
2. Enable the Standard toolbar.

Using Trigger Toolbar

Start monitoring trigger events.

Stop monitoring trigger events.

Define new trigger using Trigger Wizard.
Define new file trigger.

Define new email trigger.

Define new COM port trigger.

Define new TCP/IP trigger.

Edit the selected trigger.

RN =] B B s )

Delete the selected trigger.

Pt
—t

you do not see the trigger toolbar, do the following:
1. Select the command Toolbars from the View menu.

N
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2. Enable the Trigger toolbar.

Working with Variables

Editing Variables

You can only edit internal variables.

If variable is defined and acquired from label file, you cannot make any modifications. When
you want to change such variable, you will have to make modifications to the variable on the
label. When you will re-start the trigger monitoring, GalleryWatch will automatically update
the variable settings.

Internal Variables

Internal variables are filled automatically by the software and you do not have any influence
on them. They cannot be edited and modified, but only used from GalleryWatch. Their value
is updated for every printed label.

Internal variables are represented with the & icon so they can be easily distinguished from the
other types of variables.

The list of available internal variables:

Hostname The IP address of the connecting hosts, if using TCP/IP trigger.

ComputerName Contains the information about the computer name of a PC
computer where labels are processed, as specified from Windows
system.

DataFileName Contains full name of the temporary file with data, including the

path to the file (c:\trigger\file.dat).

This is a temporary file that contains input data received from
any type of trigger (file, email, serial port, TCP/IP) and is
actually processed in the program.

Date Contains the current system date.

DefaultPrinterName  Contains the name of the default printer on the system.

PathDataFileName Contains the path to the temporary file with data (c:\trigger\).

ShortDataFileName The same as DataFileName but contains only the filename
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without the path.

ShortTriggerFileName (Contains the name of the trigger file that actually started the
actions. Only has a value with file triggers.

SystemUserName Contains the name of the system Windows user that is logged in
and is running the application.

Time Contains the current system time.

TriggerFileName The same as ShortTriggerFileName but contains also the full
path to the file

UserName Contains the name of the user as defined in Label Gallery

software. Only has a value if you have enable user management.

Types of Variables

Each type of variable has its own icon to easier distinguish variables among each other. The
icon in front of the variable name determines its type.
The available types of variables are:

= Prompt variables that are defined in a label file.
GalleryWatch reads these variables from the label file and show them in the list.

(i Database variables that are defined in a label file.
GalleryWatch will read these variables from the label file and show them in the list.

35 Local variables.
These variables are local to the for and are not included in the label file. You can use
these variables in the actions.

%) Internal variables.
These variables are local and are not included in the label file. You can use these
variables in the actions. Internal variables cannot be modified, you can only use them.

Entering Special Characters

The easiest method of entering special characters is clicking on the small arrow button next to
the edit fields. The arrow will display a list of special characters. Just click on the character
you need.
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Alternatively, you can use special characters by using hash sign (#) followed by two
characters that represent hexadecimal ASCII code of a character. You can also use caret
character (") to specify escape (ESC, 27) character. To enter # or *, type it twice one after
another (## or ™).

Limiting Access to the TCP/IP Trigger

To limit connection to your TCP/IP triggers, do the following:

1. Double click your TCP/IP trigger to display its properties.

2. Go to the TCP/IP tab.

3. Click on the button Host Connection Permissions.
The dialog box Host Connect Options opens.

4. Type in the IP addresses of the hosts you do not want to connect to your TCP/IP
server in the text box Deny connection from the following hosts.
The connection requests coming from the entered hosts will be denied.

Note:
You can also enter the IP addresses from the hosts that you trust. Use the text box
Allow connection from the following hosts.

Running GalleryWatch Server in
Service Mode

When GalleryWatch Server runs in the service mode, it is started automatically when the
Windows operating system loads. There is no need for any of the users to log in and manually
start the GalleryWatch Server.

Note:
Service mode only works on NT-based Windows operating systems (NT, 2000, XP,
2003).

To start GalleryWatch Server in the service mode, do the following:
1. Open GalleryWatch client from Label Gallery TruePro program group.
2. Make sure the server is not running. To stop the server, select the command Stop
Server in the Activities menu.

Note:

To stop the server you can also click on the button in the server toolbar.

3. Select the command Register Service from the Tools menu.
The dialog box Service Preferences will open.

4. For Startup Type select how GalleryWatch should start as service. You probably
want to select the option Automatic to be sure GalleryWatch Server starts
automatically at each restart of the computer.

5. For Log On As select under which user the GalleryWatch Server should run.

27



GalleryWatch User Guide

Note:

To run GalleryWatch under domain user type in the user name in the syntax
<DOMAIN>\<USER NAME>. To run the GalleryWatch under the local user type in
the user name in the syntax \<USER NAME>. To run GalleryWatch under a System
Account, select the option System Account.

6. Click on the OK button.
7. Select the command Start Server from the Activities tab.

Note: When running GalleryWatch in a service mode under User Account for the very
first time, you must run it not from GalleryWatch client, but from Services (accessible
from Control Panel / Administrative Tools). This step is necessary, because the User
Account must be granted with Log on as Service property.

Note:

To start the server you can also click on the button in the server toolbar.

If you are running GalleryWatch as a service application and use .JOB files, make sure to use
UNC quotation instead of the mapped drives (e.g. LABEL "\SERVER\MY
LABELS\LABEL.LBL" instead of "G:\MY LABELS\LABEL.LBL").

When you run GalleryWatch under System Account, make sure to specify the full path and
filenames to the labels you print. Otherwise Label Gallery will not find the labels. System
Account does not have defined any user profile and there are no default folders for labels.
When you run GalleryWatch under User Account, the Windows profile and permissions
from the selected user apply. If you specify only label name in the actions, Label Gallery has
defined some default folders, where the search for the label will begin.

The best idea is to use the full path and filename to the label you will print from service mode.

Using Data Polling for Serial Devices

To define the initialization data for your serial device, do the following:
1. Select your COM port trigger in the list of triggers.
2. Select the command Edit trigger from the Edit menu.

Note:

You can also click on the button in the trigger toolbar to edit the selected trigger.

Go to the COM Port tab.

Enable the option Use data polling.

Click on the button Extract data options.

Define the polling parameters that are required by your serial device.
Click on the OK button to close Extract Data dialog box.

Click on the OK button to close Trigger Properties dialog box.

PN W

Using Initialization Data for Serial
Devices
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To define the initialization data for your serial device, do the following:
1. Select your COM port trigger in the list of triggers.
2. Select the command Edit trigger from the Edit menu.

Note:

You can also click on the button in the trigger toolbar to edit the selected trigger.

Go to the COM Port tab.

Enable the option Use initialization data.

Click on the button Initialization Data Options.

Define the initialization data that is required by your serial device.
Click on the OK button to close Initialization Data dialog box.
Click on the OK button to close Trigger Properties dialog box.

PN
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Command-line Parameters

Command-line Parameters

Command line parameters are used to pass advanced commands to GalleryWatch Server
when program starts.

Parameter should be appended after program filename;

e.g. C:\Program Files\Sato\Gallery2\Bin\GWatchS4.exe <parameter>.

Note:
The command-line parameters are available for GalleryWatch Server executable file
GWATCHS4.EXE not with the GalleryWatch Client executable file GWATCH4.EXE.

Available parameters are:

/START Triggers are activated at startup.
/STOP Triggers are deactivated at startup.

[configuration Set the configuration file which will be used instead of the default one; i.e.
file] C:\Triggers\GWatch.mis

GalleryCommands Reference

COMMENT

When developing program code or scripts it is very wise to well document your commands.
This will help you decode what the script really performs, when you will look at the code
after some time.

Use semicolon (;) on the beginning of the line. Everything following it will be treated as
script comment and will not be processed by application.
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CREATEFILE

CREATEFILE <name of the file>

This command will create a plain ASCII text file. The file will contain only one line of text
"LabelGallery" (without the quotes).

The purpose of creating such file is to signal some external application that the label
processing or printing has began or has ended.

The example of the CREATEFILE usage is printing labels with data from some files. First the
external application prepares variable data for the labels and store it into particular file. Then
Label Gallery is activated and printing starts. To inform the application when the printing
process is finished, a file can be created on the disk. It could can be a signal to the application,
that the printing application has an empty printing queue and new label printing can be
started.

DELETEFILE

DELETEFILE <name of the file>
This command deletes the specified file. You can use it in combination with CREATEFILE
command.

GalleryCommands

GalleryCommands can be used to control Label Gallery from another program that supports
DDE. In this case GalleryWatch.

Example:

LABEL "C:\LABELS\LABELI1.LBL"

SET Title = "Some string"

SET BarCode = "123456789012"

PRINT 10

FILECLOSE

Loads label stored in file C:\LABELS\LABEL1.LBL, sets variable field value to "Some
string", sets barcode value to "123456789012", prints ten labels and closes the label file.

LABEL

LABEL <name of the file>
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The command opens the working label. If the label is already opened, the program will use
this one. It is recommended to write full path name along with the file name.

Note, if variable value contains space characters or commas, you will have to enclose the
whole path in quotation marks (e.g. LABEL "C:\Program Files\SATO\Gallery
2\Samples\Labels\sample3.Ibl").

If you use LABEL command with GalleryWatch running in service mode, use UNC quotation
instead of the mapped drives (e.g. LABEL "\SERVER\SHARE\MY LABELS\LABEL.LBL"
instead of "G:\MY LABELS\LABEL.LBL").

LABELCLOSE

LABELCLOSE

The command closes the currently active label. The label application will stay opened.
FILECLOSE command does the same thing, but is depreciated. To speed up label printing do
not use this command frequently. Label Gallery can have opened more label files
simultaneously. If the label is already opened, it does not have to be loaded and thus the label
processing can be performed quickly.

LOGIN

LOGIN <username>

Performs login procedure into Label Gallery program. This is necessary when login into
Label Gallery is required.

NOTE. This is a DDE command and should not be used in batch command .JOB files.

MESSAGEBOX

MESSAGEBOX message [, caption]

Displays the message in the message box. The second parameter is used to define the title of
the message dialog box.

If the variable value contains space characters or commas, you have to enclose the text in
quotation marks (e.g. MESSAGEBOX "Insert labels in printer", Warning).

OEMTOANSI
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OEMTOANSI ON|OFF

This command works in conjunction with command SET. It puts the text that follows the
command SET in proper codepage, so that variable is assigned the proper value.

Use it to put the values following SET command to the proper codepage, so correct values
will be transferred to Label Gallery at print time.

PORT

PORT <file name>

This command overrides the printer's port name. This command is used to redirect print
output to a file. In this case specify the name of the file in the parameter file name. If the file
path or filename contain space characters, enclose the whole string in double quotes.

PRINT

PRINT quantity [, skip [, identical label copies [, number of label sets]]]
Command PRINT starts printing. The first parameter is the quantity of the labels that should
be printed.

<number> This many labels will be printed.

VARIABLE Some variable contains the information how many labels should be printed.
It can be label-defined prompted variable or a field from the database.

UNLIMITED If you use a database to acquire values for variable fields, unlimited
printing will print as many labels as there are record in the database. If you
do not use a database, there is not much sense to use this option. In this case
the maximum number of labels that thermal printer internally supports will
be printed.

The parameter skip in the command represents the number of the labels you want to omit
before first printed label on the page. The parameter is used for label printing on sheets of
paper. When the part of the page is already printed, you can re-use the same sheet by shifting
the start location of the first label. The rest of the unused labels on the page can be printed
with the help of this parameter.

The parameter identical label copies specifies how many copies of the same label should be
printed.

The parameter number of label sets specifies how many times the whole printing process
should be repeated.

If you do not need to set some of the supplementary parameters, use their default values.

Skip 0

Identical label copies 1
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Number of label sets 1

PRINTER

PRINTER <printer name>

Normally, the PRINT command prints the label to the printer specified in the label file. Using
this command you can override this defined printer and print the label to some other printer.
If the printer name contains space characters, you have to enclose it in quotation marks.

For printer name always use the system printer name as is displayed in the status line in the
Label Gallery Plus application. System printer names are usually the same as the printer
names in Printers folder from Control Panel, but not always, so pay attention. They differ only
when you are using network-connected printers, when you should use "\SERVER\SHARE"
syntax and not a printer friendly name.

PRINTJOBNAME

PRINTJOBNAME <job name>

Specifies the print job name that will be used in print manager when using PRINT command.
After printing the name is returned in normal state. Use this option to easier distinguish
between different printing jobs in the Windows spooler.

If variable value contains space characters or commas, you have to enclose the text in
quotation marks (e.g. PRINTJOBNAME "Label for printing").

QUIT

This command stops the labeling program after printing. The application is closed.

RETURN

This command returns focus to the main labeling program after the printing completes.

SESSIONEND
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The function closes data stream.

SESSIONPRINT

SESSIONPRINT quantity [, skip]

You send the data stream to printer using this function. You can use multiple SessionPrint
commands one after another and join them in single data stream. The stream is not closed
until the command SessionEnd occurs. The meaning of quantity and skip parameters is the
same as with GalleryCommand PRINT.

SESSIONSTART

All three commands(SessionStart, SessionPrint, SessionEnd) are used together. If ordinary
command SessionPrint is used, every time a complete data stream for printer is sent. If you
want to join multiple Print commands into one data stream, you can use the command
SessionStart followed with any number of SessionPrint commands and in the end use the
command SessionEnd. The stream is not closed until the command SessionEnd occurs.
These commands offer a way of optimal label printing. It is not necessary to generate a
complete data stream for each print session, you can join more sessions in one stream.

SET

SET name=value of the variable, [,step[, quantity of repetition]]

Name is the name of the variable defined on the label. If the variable isn't on the label, an
error will occur. Step and Quantity of repetition are option parameter. These parameters tell
the increment of the variable and the number of the labels before change.

If variable value contains space characters or commas, you have to enclose the text in
quotation marks.

SETDATABASE

SETDATABASE <database name> = <value>

database name The name of the currently used database as defined in the program.

value The name of the new table that should be used as data source.
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This command allows you to use some other database with the label file and not the one, that
was connected to the label file at design time.

This other database will only be used when printing labels, the label file will remain intact
with connection to the original database.

SETPRINTPARAM

SETPRINTPARAM paramname=value
This command allows you to set advanced print parameters before printing.
Currently supported PARAMNAMES are:

PAPERBIN Use it to specify from which tray the paper should be used. If the
printer is equipped with more than just one paper / label tray, you can
control which is used for printing.

The name of the tray should be acquired from the printer driver.

PRINTSPEED Use this parameter so specify printing speed. The value for parameter
varies from one printer to the other. Consult printer's manuals for
numbers.

PRINTDARKNESS Use this parameter so specify printing darkness / contrast. The value
for parameter varies from one printer to the other. Consult printer's
manuals for numbers.

SETTABLE

SETTABLE <table name> = <value>

table name 1he name of the currently used table as defined in the program.

il The name of the new table that should be used as data source.

This command allows you to use some other table with the label file and not the one, that was
connected to the label file at design time.

This other database table will only be used when printing labels, the label file will remain
intact with connection to the original table.

The new database table should be of the same type as original table. For example, you cannot
change the table from dBase to Paradox. The structure of new table has to be identical to the
original one.

You can use table from the database that is already connected to the label or from some
entirely different database.
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TEXTQUALIFIER

TEXTQUALIFIER %

Text-qualifier is the character that embeds a data value that is assigned to a variable. If the
data value includes space characters, it must be included in the text-qualifier. Otherwise only
the data until the first encountered space character is assigned to the variable.

The default delimiter for the command SET is double-quote character. Because the double-
quote character is used as shortcut for inch unit of measure, sometimes it is difficult to pass
the data with inch marks in the JOB files.

The work-around is to use the double double-quote character instead of just one, but in this
case already the incoming data stream needed to be changed. You can leave the incoming data
stream as-is and change the delimiter you want to use.

For example:

TEXTQUALIFIER %

SET Varl =% EPAK WRP BD 12"X10 7/32" %
The command TEXTQUALIFIER set the delimiter to percent sign (%). The command SET
can then use new delimiter character (%) for specifying the value to the variable Varl.

Note:

The command TEXTQUALIFIER is persistent (during single program session). If your
JOB file sets the TEXTQUALIFIER to some value, it will be used until set to another
value.
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Contact Information

Sato International Pte. Ltd.

438A, Alexandra Road, #05-01/02
Alexandra Technopark,

Singapore 119967

Tel: 65-6271-2122

Fax: 65-6271-2151

Sales: sales(@sato-int.com

Technical Support: softwaresupport@sato-int.com

Website: http://www.satoworldwide.com

Sato America Inc.

10350 Nation Ford Road Suite A
Charlotte, NC 28273
Tel: 1-704-644-1650
Fax: 1-704-644-1662

Sales: sales(@satoamerica.com

Technical Support: techsupport@satoamerica.com

Website: http://www.satoamerica.com

Sato UK Ltd.

Valley Road, Harwich, Essex England
Co12 4RR, United Kingdom
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Tel: 44-1255-240000
Fax: 44-1255-240111

Sales: enquiries@satouk.com

Technical Support: techsupport@sato-uk.com

Website: http://www.sato-uk.com

Sato Europe NV

Leuvensesteenweg, 369
1932 Sint-Stevens-Woluwe
Brussels, Belgium

Tel: 32 (0) 2-788-80-00
Fax: 32 (0) 2-788-80-80

Sales: info@be.satoeurope.com

Technical Support: technical.support@be.satoeurope.com

Website: http://www.sato-europe.com

Sato Deutschland GMBH

Schaberweg 28, 61348
Bad Homburg, Germany
Tel: 49-6172-68180
Fax: 49-6172-6818-199

Sales: info(@de.satoeurope.com

Technical Support: softwaresupport@sato-deutschland.de

Website: http://www.sato-deutschland.de

Sato Polska SP Z O. O.

ul. Wroclawska 123
55-015 Radwanice k/Wroclawia, Poland

Technical Support
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Tel: 48-71-381-03-60
Fax: 48-71-381-03-68

Sales: biuro@pl.satoeurope.com

Technical Support: technical.support@be.satoeurope.com

Website: http://www.sato-europe.com

Sato France s.a

Parc D'Activities

Rues Jacques Messager
59175 Templemars, France
Tel: 33-3-20-62-96-40
Fax: 33-3-20-62-96-55

Sales: info@fr.satoeurope.com

Technical Support: technical.support@be.satoeurope.com

Website: http://www.sato-europe.com

Sato Asia Pacific Pte. Ltd.

438A, Alexandra Road, #05-01/02
Alexandra Technopark,

Singapore 119967

Tel: (65) 6-271-5300

Fax: (65) 6-273-6011

Sales: sales(@satoasiapacific.com

Technical Support: technical@satoasiapacific.com

Website: http://www.satoasiapacific.com

Sato Shanghai Co. Ltd.

307 Haining Road, ACE Building
10 Floor, Hongkou Area
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Shanghai, China 200080
Tel: (86) 021-63068899
Fax: (86) 021-63091318

Sales: sales(@satochina.com

Technical Support: technical@satoasiapacific.com

Website: http://www.satochina.com

Sato Auto-ID Malaysia Sdn. Bhd.

No. 25, Jalan Pemberita U1/49

Temasya Industrial Park

Section U1, 40150 Shah Alam, Selangor Darul Ehsan

Tel: 60-3-7620-8901
Fax: 60-3-5569-4977

Sales: sales(@satosms.com.my

Technical Support: technical@satoasiapacific.com

Website: http://www.satoasiapacific.com

Sato Auto-ID (Thailand) Co. Ltd.

292/1 Moo 1 Theparak Road, Tumbol
Theparak, Amphur Muang
Samutprakarn 10270

Tel: 662-736-4460

Fax: 662-736-4461

Sales: sales@satothailand.co.th

Technical Support: technical@satoasiapacific.com

Website: http://www.satoasiapacific.com

Technical Support
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Online Support

You can find the latest builds, updates, workarounds for problems and Frequently Asked
Questions (FAQ) under the Support section on our Web site at www.satoworldwide.com. If
you cannot solve the problem on your own, please contact your local vendor or representative
offices listed in the topic Contact Information.
For more information please refer to:

e Label Gallery FAQ:

http://www.satoworldwide.com/labelgallery/support faq general.htm
o Label Gallery eHelp: http://www.satoworldwide.com/labelgallery/support _ehelp.htm
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trigger event

Event that must occur before GalleryWatch begins executing some actions. GalleryWatch can
detect four types of events: file, email, COM port and TCP/IP events. File event occurs when
a selected file is modified or created, email event occurs when new email is received from the
POP3 server, COM port event occurs when some data is received from the serial port and
TCP/IP event occurs when the data is received on the specified TCP/IP socket.

JOB file

This is a plain ASCII text file containing Label Gallery commands, which are to be executed.
JOB files are usually used to print a batch of labels.

trigger file

GalleryWatch monitors the modification time and date of the trigger file and if the time of the
trigger file is newer than the time the actions were last executed, actions are processed again.
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